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A.5) Overview of the “JEOL Scanning Electron Microscope” program 
On the LEFT computer, there is a single program running constantly: “JEOL Scanning 
Electron Microscope”. It is subdivided in three main parts as shown in Figure 4: 

• Top section: menu bar & main buttons. 
• Middle section: electron image display with grey buttons used to control the image 

quality, and on the right side a snapshot image of the sample holder. 
• Bottom section: instrument status (voltage, WD, spot size, etc.). 

 
 

 
Figure 4. Overview of the “JEOL Scanning Electron Microscope” program. 

 
 
 
 
The next Figures 5 to 7 present an overview of the different sections of the 

JEOL SEM program. 
 

Refer to the following Sections B to F for details on the important buttons in 
this program, and in Section G for the CL detector. 
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C) Sample loading or unloading 
The sample change procedure is summarised below. Refer also to Figures 10 and 11a,b. 
 

C.1) Opening the sample chamber 
1. In the JEOL SEM program, set the signal to SEI in the bottom section of the program. 
2. If the CL detector was in use, turn it OFF (red button on the CL control box). 
3. Turn ON the Deben infrared camera (if not already on). 
4. Open the window “Stage” and move the stage to Z = 30 mm (absolute position). 
5. If the CL is inserted (check on the IR camera!), you MUST remove the CL detector 

(see Figures 12 and 13). 
6. On the SEM column, close the valve VT-3 (tight, with the strength of two fingers). 
7. Back to the JEOL SEM program, open the window “Sample” and click “Vent”. 

 
WARNING: When the SEM is in  LaB6  mode, check the vacuum gauge 
while venting (see on the left side of the SEM) to ensure you don’t 
lose vacuum. Only the light “column” should turn orange, all other lights 
should stay green. If you lose vacuum, ask immediately for assistance!  
 
This warning does NOT apply if the SEM is in  W-mode  (see Appendix A2). 

 
8. When fully vented, open the sample chamber (see C.2 and Figure 11). 

 

C.2) Removing/Loading a sample & closing the chamber 
1. Open the sample chamber up to the back stop (use two hands!). 
2. Remove the sample and/or load your sample. 
3. If you are loading a new sample, take a snapshot with SNS: 

a. Place your sample on the holder. 
b. Click the button “SNS” in the top section. 
c. Click “Snap”. The stage will drive to the centre of the optical camera. 
d. Wait a few seconds until a snapshot of your sample appears in the SEM 

program. If you think the SNS image is not properly centred, refer to the 
calibration section to calibrate the SNS in Appendix A1. 

e. IMPORTANT! Lower again the stage to Z = 30 mm after using SNS! 
4. Close the sample chamber while looking simultaneously at the IR camera to avoid a 

disaster (e.g., sample holder touching a detector). 
5. Open the window “Sample” and click “Evac”, while pressing on the sample chamber 

door. Wait a few seconds until the vacuum catches up. 
6. Wait until the signal “Ready” appears. 

 
If this is the end of your session, you are done. Otherwise… 

 
7. Open valve VT-3. 
8. Remove the “Beam blank” and proceed with the gun activation (Section E) and the 

beam alignment (Section F). 
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D) Stage motion 
D.1) Horizontal displacement (X, Y) 
There are several ways to navigate along the X- and Y-axis in your sample: 

• Click-and-drag the mouse on the electron image. 
• Double-click on a feature on the electron image. 
• Use the joystick on the console (in X/Y mode). 
• Double-click on the SNS image of your sample (inaccurate but close enough…). 
• Use the window “Stage” and either… 

o Click on one of the coordinates and change the value in the window 
“Positioning”. Ensure you are in ABSOLUTE mode and click “Go”! 

o Click on the map view (bottom section of window “Stage”) and click “Go”. 
o Note that in the Stage window, the “Go” button will change to “Stop” as soon 

as the stage is moving. Keep your mouse on this button so you are ready to 
stop the stage if it is approaching too dangerously from a detector! 

o Other possibility (rarely used): Move the mouse along the X or Y axis of the map view. When 
the mouse pointer changes to a single or a double arrow, click to move by one step or maintain 
the click for a continuous motion. A single-arrow indicates a slow motion (micron-sized), a 
double-arrow indicates a faster motion (with acceleration feature). 

 

D.2) Vertical displacement (Z) 
WARNING: Any time you significantly move the Z-axis (> 0.5 to 1 mm) you should 

ALWAYS turn ON the infrared camera and WATCH that IR camera to ensure that the 
stage does not bump into the BSE or the CL detector! Repairs can be costly! 

To move the sample up or down along the Z-axis: 
• Open the window “Stage”, and (two options)… 
• (Safest) Use the cross-section view on the top-right of the “Stage” window: 

o Move the mouse over the vertical axis until the mouse pointer changes to a 
single-arrow (slow motion) or a double-arrow (fast motion). 

o Click a single time to move one step at a time or click and hold for a continuous 
drive (the stage will stop as soon as you release the click). 

• To move to a fixed (absolute) value, click on the Z-stage position (top-left of the 
“Stage” window) and enter a new absolute Z position. BE CAREFUL not to set a Z-
stage position that would drive the sample holder into the BSE or the CL detector! 

 

D.3) Rotation (R) 
The sample holder can be rotated manually using the small rotation knob situated between 
the X and Y stage motors on the front of the SEM door. It is best practice to rotate the sample 
on loading (i.e., before you take a snapshot using the button “SNS”), and then NOT to rotate 
the sample anymore, otherwise you won’t be able to double-click on the SNS picture and 
locate a feature. 
 

D.4) Tilting (T) 
DO NOT USE IT! There is a high likelihood of damaging the detectors (SE, BSE, EDS, or 
CL) when you tilt your sample and move in along any direction (X, Y or Z). The tilting is 
manually controlled by the knob on the bottom-right side of the SEM door. Leave it at 0° 
(horizontal)! If you absolutely need this option, contact the lab manager. 
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E) Activate the electron beam 
WARNING! Different procedure to activate the electron beam if a W or a LaB6 electron 
source is loaded (Fig. 12)! Check the note  W  or  LaB6  below the computer screen!!! 

 

If you see a BLUE sign  W-mode , refer to Appendix A2 for separate instructions. 

E.1) Activating a LaB6 electron source in “LaB6 mode” 
When a lanthanum hexaboride (LaB6) electron source is loaded, it is left active at optimum 
filament heat all the time, and only the gun bias is adjusted to control the electron emission. 
LaB6 offers a higher stability, a better image resolution, and a longer lifetime. However, it is 
fragile and expensive; it can be damaged when warmed up or cooled down too quickly. 
Please, strictly respect the following to activate the electron beam: 

• Ensure that the window “Sample” indicates “Ready” (= high-vacuum condition). 
• Check that VT-3 is opened and that the “Beam blank” is OFF. 
• Open the window “Gun”. 
• Click on “Set Bias” and click “Preset”. This calls back the default bias value (~100 to 150). 
• Do NOT change anything else in the window “Gun Alignment”! NEVER change 

the filament heat! The optimum is set by the lab manager or the assistant. 
• The “Filament heating” should read between 20 and 30 µA. 
• An SE image should now be visible in the JEOL SEM program. 
• Perform a beam alignment following the instructions in Section F. 

 

E.2) Activating a W electron source in “LaB6 mode” 
The tungsten (W) electron source is usually left in “standby” condition; the filament heat is 
just enough to keep the filament warm, but not enough to emit electron. You’ll need to 
perform a filament saturation by setting the filament heat to its optimum: 

• Ensure that the window “Sample” indicates “Ready” (= high-vacuum condition). 
• Check that VT-3 is opened and that the “Beam blank” is OFF. 
• Saturate the W-filament… 

o Insert the Faraday cup by pressing the button “PCD”. 
o Press the top-left button “LOCAL / CONFIGURATION” on the ammeter. This 

will activate the live beam current reading. If the wording “CONFIGURATION” 
appears on the ammeter display, press another time on the same button. If 
you still don’t see a live reading of the beam current, press the button “TRIG”. 

o The ammeter should indicate a varying value around zero. 
o Set the “Spotsize” around 74 to 78 (= medium to high beam current). 
o Open the window “Gun” and increase the filament heat until the emission 

current and the beam current increase. Continue increasing the heat, until the 
beam current decrease again (= “false peak”). Continue increasing the heat 
until the beam current increases again. You will reach the saturation point 
when the increase in beam current slows down or drops down slightly. 

o The emission current should read ~30 to 60 µA (or more), and the ammeter 
should read ~2 to 3 nA at the beam aperture #2. 

o Note that with a W filament, you can increase the heat rapidly. This saturation 
should not take you more than a minute… 

o When done, click on “PCD” to remove the Faraday cup. 
• An SE image should now be visible in the JEOL SEM program. 
• Perform a beam alignment following the instructions in Section F. 
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F) Beam alignment 
Once the sample has been loaded and the electron gun has been activated, you must align 
the electron beam to obtain the best image quality. Before you start the alignment, set first 
manually the beam aperture number you will need: 

• Use aperture #2 for imaging and quantitative analysis. 
• Use aperture #3 for element mapping. 

NOTE: Aperture #1 is for high-resolution images with long depth-of-field at low current & high voltage (rarely used at D-ERDW). 
 
Refer also to Figures 13 to 16 in the following pages for more details. Always optimise 
the brightness and contrast to what you need to see (Fig. 16)! 
 

WARNING: There are small differences in the alignment procedure if you are running… 
(a) quantitative analysis and SE/BSE imaging or (b) CL imaging! 

F.1) Tilt & shift optimisation of the GUN 
As for EPMA, the electron beam needs to be aligned at the gun level to ensure the beam of 
electron is going vertically down the middle of the column. This is done by adjusting the “tilt” 
and the “shift”. When a LaB6 electron source is in use, the tilt & shift adjustment is commonly 
minimal. For the W filament, it is recommended to check the tilt & shift alignment each time: 

1. Insert the Faraday cup by pressing the button “PCD”. 
2. Activate the ammeter for continuous current reading (button “CONFIG / LOCAL” or “TRIG”). 
3. Open the window “Gun”. 
4. Set a low current value under “Spotsize” (~60). 
5. Increase or decrease the X-value of the TILT until the beam current is maximised; 

repeat for the Y-value of the TILT. 
6. Increase the current (“Spotsize” > 90) and adjust the SHIFT X & Y values. 
7. Set back a low beam current (“Spotsize” ~60) and adjust again the TILT. 
8. Repeat iteratively until the last changes you apply on the TILT are minimal. 
9. Remove the Faraday cup by pressing the button “PCD”. 

 

F.2) Beam alignment for quantitative analysis or SE/BSE imaging 
1. Ensure that the signal is set to “SEI”, the magnification is low (~40x), and the “Beam 

Blank” is deactivated (you can see an image). 
2. Set the acceleration voltage and beam current (default: 15 keV; spotsize ~70 to 75). 
3. Move the stage (X, Y) position to the metal part of the sample holder. 
4. Locate a particle or some visible (even blurry) feature intersecting at ~90°. 
5. Adjust the brightness and contrast as necessary (Fig. 16). 
6. Set the Working Distance (WD) to 10 mm by clicking on the WD value on the 

bottom of the JEOL SEM program, and double-clicking on 10 mm. 
7. Do NOT change the electron beam focus anymore, as it will modify the WD! 
8. Bring the specimen up to Z-stage around 13 to 12 mm (if the specimen allows it: 

regular thin sections or 1’’ round mount). As the stage goes up, monitor the IR 
camera to avoid bumping into the detector! The image quality will improve; get the 
best image quality possible. Adjust again the brightness & contrast if necessary. 

9. Locate a smaller particle or feature and continue moving the Z-stage SLOWLY to 
lower values (down to 10-11 mm on thin section or 1’’ mount) until the image is sharp. 

10. Increase the magnification and repeat the Z-stage adjustment until the sharpest 
image is obtained. PROCEED with CAUTION: Do NOT bump into the BSE detector 
when moving the stage up (= at a lower absolute Z-value)! 
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11. Continue increasing the magnification up to at least 2000x to 4000x, relocate an even 
smaller particle (~1 µm-sized), readjust the brightness & contrast, and perform a final 
adjustment of the Z-stage position; final Z-position ≈ 10-11 mm (on TS / 1’’ mount). 

12. Activate the button “Wobbler” (in the top section) and adjust manually the X- and Y-
axis of the beam aperture until the particle does not move sideways (adjustment 
knobs are on the SEM column). If you see the particle stretching along one diagonal and then 
along the other diagonal, this is a sign of astigmatism (see next). 

13. Once properly adjusted, deactivate the “Wobbler”. 
14. Correct for the astigmatism using the “Stigma X” and “Stigma Y” buttons on the top 

of the electron image, first with “coarse” adjustments (= right-click + hold, then move 
up or down), then with fine adjustments (= left-click + hold, then up or down). 

15. If necessary, iterate between the Z-stage position and the astigmatism correction to 
improve the image resolution, and check with the “Wobbler” that all is well aligned. 

 

F.3) Beam alignment for CL imaging 
1. Set the signal to “SEI”, the magnification to ~40x, and deactivate the “Beam Blank”. 
2. Set the acceleration voltage and beam current (default: 15 keV; spotsize ~74). 
3. Turn ON the infrared camera. 
4. Set the stage to Z = 30 mm, and insert the CL detector (Section G.1 and Fig. 14): 

a. Unlock the mechanism; lock is below the arm of the CL detector. 
b. Turn the black knob clockwise to insert the CL detector inside the SEM, and 

simultaneously watch the IR camera (do not bump into detector or sample!). 
c. Continue inserting the detector until you reach the backstop. 
d. You should now see the hole of the CL detector on the SE image. 

5. Move the stage to the metal part of the sample holder; increase the magnification to 
~100 or 200x so you don’t see the edge of the CL detector anymore. 

6. Locate a small particle or some marks intersecting at ~90°. 
7. Adjust the brightness and contrast as necessary. 
8. While looking at the infrared camera, move the Z-stage position to around 16-17 mm. 

With normal thin section or round mount, you can move rapidly up to 19-18 mm, and 
then move slowly towards 17-16 mm (16.5 is fine for regular thin section or 1’’ round 
mount). Don’t go below 16 mm! Adjust again the brightness & contrast if necessary. 
WARNING: Do NOT bump into the CL detector!!! After this, do NOT change the 
Z-stage position anymore! 

9. Turn OFF the IR camera. 
10. Observe the SE image and adjust the electron beam focus using one of the following: 

a. Knob “Focus” on the console (with the option “Coarse” activated); 
b. Button “Focus” on top of the electron image (right-click for coarse change). 

11. When the image appears to be on focus, increase again the magnification to 200 or 
500x, and adjust the focus in coarse then in fine mode. Continue increasing the 
magnification up to at least 2000 to 4000x, relocate an even smaller particle, and fine 
tune the focus. The WD should now be around 16 or 17 (= matching the Z). 

12. Activate the button “Wobbler” (in the top section) and adjust manually the X- and Y-
axis of the beam aperture (knobs on the SEM column) until the particle does not move 
sideways. If you see the particle stretching along one diagonal and then along the 
other diagonal, this is a sign of astigmatism (see next). Deactivate the “Wobbler”. 

13. Correct for the astigmatism using the “Stigma X” and “Stigma Y” buttons on the top 
of the electron image, first with “coarse” adjustments (= right-click + hold è move up 
or down), then with fine adjustments (= left-click + hold). 

14. If necessary, adjust again the focus and re-iterate the astigmatism correction to 
improve the image resolution, and check with the “Wobbler” that all is well aligned. 
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H) Pathfinder program 
The Thermo “Pathfinder” program controls the EDS system and acquires electron images 
(SE, BSE, or CL). The JEOL SEM program can also acquire images, but it is not as easy to 
use and certainly not as versatile as the “Pathfinder” program. 
 
Note that any data acquired by Pathfinder are stored in a specific “Project” folder on the “D:\” 
Data drive. Whenever you create a project, you must save it IN YOUR OWN User Folder 
such as “D:\LastName FirstName\Your project…”. 
 
WARNING: Data backup is NOT guarantee. Data can be deleted at any time without any 
notice (especially old and heavy data: element maps, mosaic images, etc.)! You MUST 
retrieve all your data and get a backup as soon as your analyses are over! 
 

H.1) Starting “Pathfinder” 
Refer also to Figure 18. It is assumed that… 

• Your sample is loaded and set at the proper Z-stage position (Section C). 
• The electron beam is active (Section E)  
• The electron beam is aligned, and the optimum focus is reached (Section F). 

 

• Start the “Pathfinder” program (if not already running). Shortcut on desktop:   
• When starting “Pathfinder”, you will have to create or select a “Project” folder where 

all data will be automatically stored. It is recommended to create a NEW project 
folder per analytical session1… 

o If not existing, create a folder with your last name and first name… 
§ Select the drive “D:\”; 
§ Click on “New Folder” (yellow folder) to create a new sub-folder and 

name it with your “LastName FirstName”. 
o Select your user data folder “D:\LastName FirstName”. 
o Click on “Create New Project” to create a new “Project” folder (green folder). 
o Enter a name for your project, for instance “2022-04-19 PF test” or “Sample 

79”, click OK to create this project, and select it. 
o IMPORTANT! Choose the project template “silicate calibrated analysis” 

or a templated appropriate to your work! It will set some default parameters for 
your EDS & imaging setups, ideal for most situations. If you forgot to set the 
project template, you must (a) re-open the “Project Explorer”, (b) select your 
folder, (c) choose the correct project template, (d) press “Reset”, and (e) press 
“Open Project”. 

o Click “Open Project”. 
 

• To OPEN an existing project (to append data to it or to re-process data)… 
o Click on button “Project Explorer”  if it is not opened. 
o Select the “Project” folder to use (green folder). 
o Click “Open Project”. 

 
1 Some researchers such as experimentalists might consider creating a unique “Project” folder per 
experimental run. Just be aware that a lot of data stacked up in a single folder is not good when it comes time 
to find back something specific. 

Otherwise, when creating a “per session” project folder, it can be useful to add the date when you 
acquire the data to the name of your project folder so you can link it to your notes in your laboratory book. 
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I) SE, BSE, or CL imaging with Pathfinder 
In the following, it is assumed that… 

• The Thermo “Pathfinder” program is running. 
• A Project folder is opened (see Section H.1). 

 

I.1) Acquiring an SE, BSE, or CL image 
Adjust the signal & field-of-view on the JEOL SEM program… 

• Select the desired electron signal: SEI for secondary electron, BEIW for 
backscattered electron (BSE), or BEIC2 for cathodoluminescence.  
NOTE: If you choose the BEIW signal, select also the mode:  

– COMPO (most common, compositional effect). 
– TOPO (topography ~ similar to SEI but lower quality). 
– SHADOW (mix of topography and compositional effect). 

• Adjust the stage position and set the magnification to the desired field of view. Avoid 
low magnification (< 70x) as you will have edge effects (shadow & deformation). 

• Adjust the Z-stage position (for SE, BSE images at fixed WD) or the focus (for CL 
images) to get the sharpest image possible. 

• Adjust the brightness and contrast (Fig. 16). For CL image, you must adjust the 
brightness and contrast directly on the CL controller box (Fig. 17b). 

 
To acquire a single SE, BSE, or CL image (see also Fig. 20)… 

1. In Pathfinder, select menu “View > Electron Imaging Mode”. 
2. Click on the gear button  “Electron Image Setup”. 
3. Enter a name for your image under “Experiment Name”. 
4. Set the image acquisition time (default: 2 frames, 10 s each) and the image size 

(recommended: 1024 x 768). 
5. Click on the button “Get Image” to start the acquisition. 
6. Optional: click on “Image Settings” to change the brightness and contrast. 

 
The image is automatically stored at the end of the acquisition, and an entry will be created 
in the bottom-right panel. You can then at any time click on one of the saved images to 
select and display it. If necessary, click on  to rename the file or on  to delete it. 
 
Image information (including stage coordinate) are found in the middle panel. 
 
Continue with the acquisition of the next image: move the stage in position, adjust the 
brightness & contrast as necessary, change the “Experiment Name” and click again “Get 
Image”, etc. 
 
At the end of your session, don’t forget to reserve time to export your images with a scale 
bar by selecting menu “File > Export > Export as Full-Res TIF”. If you have tens of images, 
this can take some time… 
 

 
 

 

 
2 BEIC requires first that you insert and activate the CL detector! Refer to Section G.1 for details. 
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I.2) SE, BSE, or CL mosaic imaging 
The mosaic imaging is a grid of X * Y individual images stitched together for imaging large 
areas (> 2 mm). In the following, it is assumed that you have set the image setting 
(resolution & acquisition time, see I.1 and Fig. 20). 
 
On JEOL SEM program:  

• Select the desired electron signal: SEI for secondary electron, BEIW for 
backscattered electron (BSE), or BEIC3 for cathodoluminescence.  
NOTE: If you choose the BEIW signal, also select the mode: COMPO (most common, compositional 
effect), TOPO (topography, like SEI but lower quality), or SHADOW (mix of TOPO + COMPO). 

• Set the magnification (e.g., 70-150x for large areas, higher mag for more details). 
• Adjust the Z-stage position (for SE, BSE images [at fixed WD]) or the focus (for CL 

images) to get the clearest and sharpest image possible. 
• Adjust the brightness and contrast (Fig. 16). For CL image, remember to adjust the 

brightness and contrast directly on the CL controller box (below the IR camera). 
 
To acquire a mosaic image in Pathfinder (Fig. 21): 

1. In “Electron Imaging mode”, click  to enter the “Automation” mode. 
2. Enter an “Experiment Name” such as sample name with area ID, etc. 
3. Select “Grid” under the “Acquisition Type”. 
4. Click on “Add (Change) Location” and follow the instructions: 

a. Move the stage to the upper-left corner of the mosaic image to acquire and adjust the Z-
stage position (don’t change the electron focus, only the Z-stage position if necessary!). 

b. Move the stage to the lower-right corner of the mosaic image to acquire and adjust the Z-
stage position. 

c. Optional: Move the stage to another corner and adjust the Z-stage position. 
This will create an entry in the list below.  

5. Click on “Edit Location” to modify it (e.g., adding an overlap). 
6. In “Edit Positions” window you can… 

a. Set an overlap: 10% recommended to avoid black squares with no data. 
b. Update the magnification (e.g., after opting for a different magnification). 
c. Modify the grid label name, yet the default “Grid” name is usually fine (it will 

be appended to your “Experiment Name”). 
d. Modify the two reference positions (upper-left and lower-right corners) 
e. Click “OK” to validate any modification to this grid acquisition. 

7. Press “Start Automation” to launch the image acquisition. 
 
GOOD NEWS! Compared to NSS, it is now possible to define more than one grid! It 
should automatically rename your second grid entry “grid_1”, then “grid_2”, etc. 
 
 

 
WARNING: NEVER check the box “Beam OFF”! 

 
 
 

 
3 BEIC requires first that you insert and activate the CL detector! Refer to Section G.1 for details. 
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I.3) Tips on image acquisition time & magnification 
• Always use aperture 2 (or 1) when acquiring images. 
• You can try to increase/decrease the current and adjust the counting time. A medium 

current is recommended for most applications (spotsize 70-80) as it gives a strong 
signal and a decent sub-micron imaging resolution. However: 

o A lower current (spotsize 50-70) will yield a weaker signal (è longer imaging 
time required) and provide a higher spatial resolution (<< 1 µm). 

o A higher current (spotsize >80) will significantly increase the signal but will 
yield a lower spatial resolution and is NOT recommended for imaging. 

o NOTE: If a super-high spatial resolution in SE mode is required (e.g., for 
imaging foraminifera, small 3D-image of crystal), use a higher voltage (20 or 
25 keV) and the beam aperture 1! 

• Prefer a medium to high magnification (> 100x) to avoid problems deformation at 
the edges or shadow effect from the BSE or CL detector or from the beam aperture. 

• For mosaic images, select a magnification sufficient to reveal all the feature to 
highlight (i.e., consider the true pixel size in micrometre). Check the Appendix A4 
for determining the pixel size of one individual image. Do not choose a too high 
magnification that would require to acquire way too many images! For instance, a 
magnification between ~70 and 150x is commonly used for a mosaic image of a full 
thin section with large grains (> 50-100 µm), but a higher magnification and most 
likely smaller area would be required to reveal micron-sized phases in smaller areas. 

 

I.4) Exporting images with scale bar 
Images are stored immediately when the acquisition is over. However, you will still need to 
export individual images to get an image with a scale bar: 

• Select the image (or Point ID) to export. 
• Click on menu “File > Export > Export as FullRes TIF…”. 

 
For mosaic images, you will first need to MERGE all the files by selecting the menu “Batch 
Processing > Create Montage”. Export then the resulting merged image as a full resolution 
TIF image (menu “File > Export as FullRes TIF…” as described above). 
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J) Quantitative (or qualitative) EDS analysis 
In the following, it is assumed that… 

• The Thermo “Pathfinder” program is running. 
• A Project folder is opened (see Section H.1). 

 
EDS acquisition can be considered as (a) “qualitative” for instance to check the presence or 
absence of some major to minor elements, or (b) “quantitative” providing you consider a 
standard-based quantification (which is what we do in our lab). The following assumes your 
goal is to get standard-based quantitative analysis: 

• “Spectrum”: acquire a single EDX spectrum of the currently scanned area. 
• “Point ID”: acquire an image and select point(s) or area(s) to be analysed by EDS 

in this image. This is most likely what you need… 
 
WARNING: If your goal is to perform quantitative analyses, you MUST… 
 

(1) Load the project template “Silicate calibrated analysis” if you want to run quantitative 
analyses (see Section H.1, Fig. 18)! If you haven’t set this template when creating a new 
project, click again on the “Project Explorer” , select “silicate calibrated analysis”, press 
the “Reset” button aside, and confirm. 
 

(2) Ensure that you have set the Working Distance (WD) to 10 mm. If this is correct, 
Pathfinder will indicate in the footnotes WD 9.7 (at 15 keV) or 9.8 (at 20+ keV). 
 

 

 

Figure 22. SEM & EDS information found at the footnote of the Pathfinder program: 
acceleration voltage (HV), magnification (Mag), working distance (WD), last beam 

current measurement, stored count rate, and dead time. 

 

J.1) Load standard data 
If your goal is to obtain accurate quantitative data, you must load the appropriate standard 
data to obtain standard-based quantitative analysis (see also Fig. 23): 

1. Select your analysis mode (e.g., “Spectrum” or “Point ID”). 
2. Click on “Spectrum Processing”. 
3. Click on “Quant Setup”. 
4. Click on “Standard Manager…”. 
5. Click on “Load” to load a set of standards. Alternatively (5a), you can select an 

individual standard in the list and click “Add selected”. (5b) To remove a standard 
from your list, select it and click “Remove selected”. 

6. Select the latest standardisation for your type of analyses (e.g., silicate, carbonate) 
and click “Load”. 

7. Validate your choice of standard. 
8. Your choice of standards will be displayed in the “Quant Setup” and elements will be 

highlighted in purple in the periodic table (i.e., always quantified, even if not present). 
9. If you already have acquired data, press the “Process” button to re-quantify the data. 
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Verify this list is correct. You can also look at the periodic table in the bottom-left panel: all 
elements that have a standard defined are highlighted in purple (see Fig. 23). 
 
WARNINGS on the choice of standards / elements: 

• You MUST select standards acquired at the same VOLTAGE as your analyses 
(usually 15 kV)! 

• If multiple standards are available such as Fe2O3 and FeS2 for Fe at the same kV, 
choose the one the most similar to the type of phase to be analysed. 

• The standardization on the EDS holds well for months and it is tested periodically. 
However, if you think it needs a new standardization, ask for assistance. 

• It is better to select your standards BEFORE acquiring any quantitative data! If 
you have already acquired data and you change the list of standards, you will have 
to reprocess all your data, and this can be time consuming…  
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J.2) Single Spectrum 
J.2.1) Acquiring a single EDX spectrum 
To acquire a single EDX spectrum (Fig. 24)… 

1. Choose the analysis mode “Spectrum”. 
2. Click on the right gear button  to set the EDS acquisition conditions: 

a. Recommended “Live Time Limit”: 
i. 5 to 10 s for quick ID. 
ii. 30 to 60 s for quantitative analysis (30 s = default). 
iii. Considering a longer acquisition time? è EPMA analysis / ask for help. 

b. Leave the default values for the Energy Range (0 to 20 keV), unless you are 
working above 20 keV (then choose “40 keV” for the high energy cutoff). 

c. IMPORTANT for QUANTITATIVE analysis: “Time Constant” must be set 
to “Rate 2” as all standards are acquired using this time constant. 

d. Ensure button “Beam current”  is active. 
3. Move the stage in position for the analysis, fine tune the Z-stage position, and 

increase the magnification (usually > 1000x) to scan only over the phase of interest.  
4. Adjust the current (spotsize) to reach a deadtime (DT) of 20-30%, which is shown in 

the footnote of Pathfinder (Fig. 22). Decreasing the current will reduce the amount of 
X-ray produced, and thus the DT. 

5. Enter an “Experiment Name” for your analysis, e.g., “SampleABC area # phase XX”. 
6. Click on “Start Spectrum”. The remaining acquisition time will be indicated in a green 

progress bar on the top of the program window. Remember that the “real” acquisition 
time is the sum of the “live” time (when the instrument is processing the signal, as 
defined in 2 above) and the deadtime (DT, when the instrument cannot process the 
signal). 

7. Process your data by clicking on “Spectrum Processing”. 
 
See details for quantitative analysis in the next Section J.3 about Point ID. 
 
J.2.2) Navigating in the Spectrum panel 
EDX spectrum acquisition is shown in one panel. To “navigate” in this spectrum… 

• Click-and-drag horizontally (or vertically) to change the energy range (or the 
intensity range). If you reach the minimum, the spectrum will be expanded (zoom). 

• Double-click on the spectrum to return to the default full view. 
• To zoom-in and zoom-out on a specific energy position, place the cursor over the 

energy range of interest and use the mouse-wheel. 
 
J.2.3) Exporting quantitative results for one or more single spectrum 
To export quantitative analysis from a single spectrum: 

• Click on menu “Batch Processing > Spectrum Analysis…”. 
• Select all EMSA files to be treated, using CTRL to select individual files or SHIFT to 

select continuous series of files, and click “OK”. 
• Choose a filename and location for the result file to be created. 
• Click “Save”. A CSV file with all quantitative data for the selected EMSA file is created. 
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J.3) Point ID 
J.3.1) Acquiring Point ID analyses 
To acquire multiple EDS analyses in a given area with a BSE image (Fig. 25)… 

1. Select “Point ID” on the analysis mode panel. 
2. Click on the left-gear “Electron Image Setup” to set the imaging conditions (see 

Section I.1; Fig. 20), usually 2 frames of 10 s each at 1024 x 768 pixels resolution. 
3. Click on the right-gear “Experiment Setup” to set the EDS acquisition conditions 

(see Section J.2; Fig. 24), e.g., 60 s acquisition time at time constant “Rate 2”. 
4. If you are running quantitative analyses, ensure the required standards are loaded: 

a. Select “Spectrum Processing” and “Quant Setup”. 
b. Click on the green arrow to expand the setting options. 
c. Check the list of standard and modify it if necessary (see Fig. 23). 
d. Ensure the options “Filter Fit” and the “Proza” correction method are set. 
e. If analysing oxide: Check the box “Calculate all elements as compounds”, and set the 

number of oxygen atoms for a cation normalisation. Otherwise, uncheck it. 
5. Move to an area of interest and set the magnification ≥ 500x. At lower magnification, 

you will get inaccurate results on points acquired near the edges. 
6. Ensure WD is 9.7 mm (at 15 keV), and adjust the spotsize to reach 20-30% DT. 
7. Enter a name for your analysis under “Experiment Name”. 
8. Acquire an image by clicking on “Get Image”. 
9. Set one or more points, rectangle, spot, or polygon areas on the BSE image: 

a. Ensure the “Instant” option is deactivated. 
b. Select the shape you need (rectangle, spot, polygon…). 
c. Draw shape(s) to be analysed on the BSE image. 
d. WARNINGS: (1) For accurate results, avoid setting points to close to a phase boundary 

or a crack. Keep also in mind that the actual analysed volume is probably a sphere of 1-2 µm 
diameter! (2) For beam sensitive phases (hydrous, carbonate, alkali-rich, etc.), it is best 
practice to analyse a “large” area (è 2-3 µm-sized rectangle or circle). (3) Always set your 
shape in a homogeneous domain. Accuracy is NOT guaranteed for inhomogeneous domain. 

10. When ready, click “Start Spectrum”. Progress of EDS analysis will be indicated by 
the green bar on the top of the program window. 

11. Quantitative results will be displayed in the bottom-middle panel (see Fig. 26). 
 
J.3.2) Reprocessing Point ID data 
To review the acquired results (Fig. 26)… 

1. Select the point of analysis in the list of results or use the “Select” tool. 
2. Quantitative results for the selected point are displayed. Click on “Options…” to 

choose the data to be displayed (see Section J.3.3 for details on each option). 
3. You can activate the “Comparison mode” to compare two or more spectra. Choose 

to normalize the data to the live time or to a specific element. You can also activate 
the “calculated spectra”  for synthetic, background, or residual spectrum. 

4. To export in a CSV file your quantitative analysis, select menu “Batch Processing > 
Point ID Analysis”, and select all Point ID results to export. Validate your choice and 
enter a name for the CSV file.  

5. You can also choose the Word or PPT export (on the far left-side of Pathfinder 
window) to generate a report with the EDS spectra. 

 
During the analysis or if you changed the list of standards linked to your project, you will 
need to force reprocessing the data manually: 

• Click on “Identify Setup” under “Spectrum Processing” and click “Process”. This will 
force re-identifying all X-ray peaks / elements. 

• Click on “Quant Setup” and click “Process” to re-quantify the data. 
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J.3.3) Choice of data to display and to export 
You can choose the data to be displayed or exported by clicking on “Options…” in the 
quantitative results panel. The following entries are available (in bold are the most 
important entries, and in small italic are the rarely used ones): 

• Line Type 
• Intensity, Intensity Error: Total peak intensity (peak and background, with error). 
• Net Counts, Net Error: Background corrected peak intensity (with error). 
• Weight-%, Weight-% Error: Results expressed as element weight-%. 
• Z, A, F, and ZAF factor: matrix correction factors. 
• Atom %, Atom % Error: atomic proportion assuming a total of 100 atoms. 
• Source 
• K-ratio, K-ratio Error: Ratio of measured net intensity over standard net intensity. 
• K-factor: Calculated K-ratio assuming a pure element standard. 
• Norm. Wt %, Norm. Wt % err, Norm. Compound %: Data normalized to 100%. 
• Chemical Formula: List of the compounds name (= oxide name). 
• Compound %: Results expressed as oxide weight-%. 
• No. of Cations: Atomic proportion from the oxygen normalisation (see Fig. 25, 5e). 
• Standard Name: Name of the standard file used (usually written in your lab notes). 

 
You can also set the uncertainty confidence level (usually set to 2 sigma) and the number 
of decimal places (usually left at 1 or 2). 
 
 
J.3.4) Probelab ReImager 
Probelab ReImager is designed to read your project folder and export in a few clicks all your 
Point ID images with scale bar & EDS analysis points to a TIF file. You will need a 64-bit 
Windows or MacOS platform. 
 
Get more info about it and download it here: https://reimager.probelab.net/  
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K) EDS element mapping 
 

WARNING: For element mapping, use the beam aperture #3 (for high current)! 
 
The “Spectral Imaging” option of Pathfinder (Figs. 27 to 30) is used you to acquire element 
maps and to perform a phase analysis. It is recommended for determining the modal 
proportions of minerals over a small area (50 – 1000 µm) for complex or fine-grained 
material, for a phase map over a larger area (> 1 mm). The following describes only the 
basics for acquiring and treating a spectral image using the capabilities of Pathfinder. It is 
recommended to use the package “iSpectra” written for “IgorPro” by Dr. Christian 
Liebske to treat your element maps. 
 
Mapping a large area: You must use the analysis automation option to obtain a mosaic 
element mapping. The way you set this up is very similar to a regular mosaic imaging: set 
up first your element mapping conditions (see Section K.1) and use the “Automation” tool 
to prepare the grid for your mosaic mapping (see Section I.2). 
 

K.1) Acquiring an element map with the mode “Spectral Imaging” 
To acquire a single element map (see Fig. 27)… 

1. Select the mode “Spectral Imaging” and enter a name for you acquisition. 
OPTIONAL: In the bottom-left panel select “Element Setup” and mark your element 
of interest as “Always identified” (purple-coloured). If you have standards loaded, the 
related elements will be already marked as “Always identified”. 

2. Move to the area of interest, adjust the Z-stage focus, and set a magnification ≥ 70x. 
3. Set the analysis conditions: 

a. “Electron Image Setup”: Set the condition for the base BSE (or SE) image 
(e.g., 1024x768 pixels, 2 frames, 10 s each; see Section I.1, Fig. 20). 

b. “Spectral Image Setup”: Set the time constant between Rate 5 and Rate 7. 
For a higher spectral resolution, opt for rate 5. For a higher throughput (higher 
current, more X-rays), opt for rate 6 or 7. Set the resolution of your element 
map, the number of frames, and the time per frame. Refer to Appendices A4 
& A5 for choosing the optimum resolution & analysis time or ask for 
assistance. Suggestion: 15 to 30 frames, 60 s per frame, 256 x 192 px. 

4. Enter a name for your element map under “Experiment Name”. 
5. Ensure WD is 9.7 mm (at 15 keV) and adjust the spotsize to reach 20-30% DT. At a 

rate of 5 to 7 (= medium time constant), you should reach a stored rate of ~50’000 to 
~80’000 counts per second (= 50 to 80 kcps). 

6. Click on “Get Image” to acquire a BSE (or SE) image. 
7. When the image acquisition is over, click on “Start Map” to start the acquisition. 
8. During the acquisition, the buttons “Stop Map”, “Abort”  and “Pause”   appear: 

• “Stop Map” will stop the acquisition at the end of the current frame and save the map. 
• “Abort” will stop immediately and won’t save anything. 
• “Pause” will temporarily pause the acquisition. 

The remaining acquisition time is displayed on the top. Elements present in the 
mapped area are automatically detected the using the full EDX spectrum. Element 
maps of the “Identified” (green) and “Always identified” (purple) elements are 
extracted. When the acquisition is finished, add/remove elements using the periodic 
table and request to reprocess the data to extract more elements (see Section K.2). 
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K.2) Treating element or phase maps 
K.2.1) Extracting “Element maps” 
To extract element maps (see Fig. 28)… 

1. Select your Spectral Imaging acquisition in the bottom-right panel. 
2. Mark the element you absolutely need for your research as “Always identified” to 

force their identification. Note that if you loaded some standards, the associated 
standard elements will be already marked as “Always identified”. 

3. Click on “Map Processing” (middle-right panel) to change the map treatment options. 
4. Select “Quant” to display quantified data (watch out for low precision results!): 

a) Select in the list the type of data to export (atomic %, weight %, etc.). 
b) Change the “Output resolution” and “Processing Accuracy” to a higher quality 

setting if needed (longer processing time), or just use the default. To improve 
counting precision (to the cost of loss of spatial resolution), set the “Kernel 
Size” to 3x3 or higher (pixel averaging). This is recommended to smooth a 
map that would be too noisy (low counts per pixel). 

c) Click “Process”, and wait for the calculation to complete. 
 
See Section K.3 for additional options once the element maps are extracted. 
 
K.2.2) Extracting “Phase maps” 
To extract phase maps (see Figs. 28 & 29)… 

1. Select your Spectral Imaging acquisition in the bottom-right panel. 
2. Mark the element you absolutely need for your research as “Always identified” to 

force their identification. If you loaded some standards, the associated standard 
elements will be automatically marked as “Always identified”. Watch out for false 
positive, your pixel statistics is very poor! 

3. Click on “Map Processing” (middle-right panel) to change the map treatment options. 
4. ….quant… see above 
5. To extract phase maps… (see also Fig. 29) 

a) Select “COMPASS”. If the “Phases” button is available continue to (b), 
otherwise click first on “Process” using the default options: 

i. Method set to “Area” 
ii. Background set to “Use Internal Model”). 

b) Click on “Phases” and click on “Auto” using the default Phase Map Type 
(Maximum Intensity). The processing can take a few minutes depending on 
the options selected. See Figure 29 for details on how to extract phase maps. 

c) Once the phase maps are generated, you can… 
i. Single-click on a phase name to activate or deactivate its overlay on 

the base BSE (or SE) image. 
ii. Double-click on a phase name to rename it (when identified). 
iii. Click on an image to change its setting (colour, brightness, contrast…) 
iv. Select “File > Export > Export Image to Full-Res TIF” to export the 

BSE/SE image with phase overlaps. 
 
K.2.3) Extracting and quantifying a “Spectrum” from of an element map 
To extract a spectrum, for instance, to properly identify a phase (see Fig. 30)… 

1. Activate the “Rectangle”, “Spot”, or “Polygon” option under the BSE image. With the 
rectangle option, move and resize the rectangle to the area of interest. 

2. The sum of all EDX spectra from the selected pixels is shown as an “Extracted 
Spectrum” in the bottom panel, which should ease your phase identification. 



48  J. M. Allaz © May 6th, 2022 

3. OPTIONAL: If you want to save this extracted spectrum as a single EMSA file… 
a) Select the area with the rectangle / spot / polygon tool. 
b) Select the analysis mode “Spectrum”. 
c) The “Extracted Spectrum” should be displayed. 
d) Select menu “File > Save as…” and save the spectrum as an EMSA file. 
e) You can also quantify this spectrum (providing you are using standards) as 

you would quantify a point analysis (in “Spectrum” or “Point ID” mode). Be 
careful, the analytical precision is likely to be poor as there are very low counts 
on each pixel, even after pixel-averaging, unless you have hundreds of pixels 
included! 

 

K.3) Additional tips on map treatment after extraction 
• To overlay one or more map(s) on the BSE image, select or unselect an element or 

phase map by clicking on its name (background will turn black when selected). 
• In “Phases maps” mode, click on any of the phase map to show the “Extracted 

Spectrum” of all pixels composing this phase. Be aware that this option will likely 
include pixels from other phases surrounding the phase of interest… 

• Double-click on the name of a phase to rename it once you have properly identified 
it. Use the spectrum extraction tool to help with the identification (Section K.2.3)! 

• To export the results after setting the overlay maps (elements or phases) on your 
BSE image, select menu “File > Export Image as Full Res TIF”. 

• All (last) map treatment you perform (element or phase maps) will be automatically 
saved, and some of these files are already TIF files (images!). Look at Appendix A6 
for a listing of the file handling and signification of each file extension. 
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A2) Activating the SEM in W-mode 
In a normal situation, the SEM is working under ultra-high vacuum (UHV) using an ion pump 
in the gun. However, some situation might force us to shut down the ion pump and to work 
only under “high vacuum” condition using only the rotary and the turbo pumps. Such an 
exceptional condition is commonly related to a vacuum leak in the gun or a problem with 
valve VT-1 or VT-3 and is only temporary. In this situation, only a W-filament can be used. 
 
 

 WARNING: Follow these instructions ONLY when… 
 (1) the SEM is loaded with a W-filament (green sign)  
 AND (2) when the SEM is in “W-mode” (blue sign). 
 

 
The vacuum reading on the box on the left side of the SEM will be OFF. The light “UHV” will 
always remain orange, and both lights “Column” and “HV” will be either green when a 
sample is loaded (SEM under high vacuum) or orange when you open the sample chamber. 
 
When the W-mode is in use, both valves VT-1 and VT-3 are OPEN. This implies that each 
time you vent the instrument, the vacuum is lost in the chamber and in the gun. You must 
therefore TURN OFF the filament heat each time you perform a sample change or at the 
end of your session. Follow these instructions to LOAD your sample: 

• Lower the filament saturation to zero and turn OFF the electron gun (button HT OFF). 
• Click on “Sample” and press “Vent”. The HT button will turn grey and state “Wait…”. 
• Open the chamber and load your sample. 
• Take a photo with “SNS” as usual. Then, lower the stage to 30 mm. 
• Close the sample chamber (keep an eye on the IR camera!). 
• Press the button “EVAC” to pump. 
• Wait for the signal “READY”. 
• The HT button should now be blue. Press on it to turn HT button ON (green). 

 
Perform then a filament saturation by setting the filament heat to its optimum (Fig. A5): 

• Remove the “Beam blank”. 
• Insert the Faraday cup by pressing the button “PCD”. 
• Press the top-left button “CONFIG / LOCAL” on the ammeter. This will activate the 

live beam current reading. If the ammeter displays “CONFIGURATION”, press 
another time on the “CONFIG / LOCAL” button. If you still don’t see a live reading of 
the beam current, press the button “TRIG”. 

• At first, the ammeter should indicate a value around zero. 
• Set the “Spotsize” to around 74-78 (= medium to high beam current). 
• Open the window “Gun” and increase the filament heat until the emission current and 

the beam current increase. Continue increasing the heat, until the beam current start 
decreasing again as you are passing the “false peak”. Continue increasing the heat 
until the beam current increases again. You will reach the saturation point when the 
increase in beam current slows down significantly or plateaued or drops down slightly 
(= saturation point). When you are at saturation lower by one or two clicks the heat. 

• The emission current should read at least ~30 to 50 µA or more. 
• The ammeter should read ~2 to 3 nA when the beam aperture #2 is in use. 
• When done, click on “PCD” to remove the Faraday cup. 
• You should now see an electron image on the screen. 

 
Perform then a beam alignment following the instructions in Section F. 
 

W-
mode
Ion pump is NOT

working, no UHV...

W
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A3) Characteristic X-ray  
 

 

Figure A3. All common electron transitions and characteristic X-ray generation. 
 

From Goldstein et al. (2003) “Scanning Electron Microscopy and X-Ray Microanalysis” (Fig. 6.9, p. 280). 
Original in Woldseth (1973) “X-Ray Energy Spectrometry”. 
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A4) Image resolution 
Relationship between the actual pixel resolution (expressed as micrometre) and the 
magnification & image resolution.  

• For regular SE / BSE images: a resolution of 1024 x 768 pixels is recommended. 
Higher resolutions are possible with Pathfinder. However, keep in mind that if you 
double the width & height (2048 x 1536), you quadruple the area to scan and the total 
acquisition time (e.g., 2 x 40 sec instead of the regular 2 x 10 sec for good quality). 

• For EDS element mapping: consider smaller images (e.g., 256 x 192 pixels), and 
select an image resolution and magnification such that the pixel size is equal or larger 
than the expected projected interaction area of the electron beam and the sample 
(typically 1-2 µm diameter for silicates at 15 to 20 keV, smaller for heavier phases). 
In any case, choosing a pixel resolution less than 0.5 µm is NOT recommended. 

 
 

 

Figure A4. Table of actual pixel size in micrometre as a function of the image size in pixels 
and the magnification. Values are only valid at a working distance of 10 mm. 
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A5) EDS mapping time & element map quality 
For element mapping by EDS, you should consider the total X-ray counts received on each 
pixel. A minimum of ~1000 counts on each pixel is recommended. Above ~4000 there is no 
significant gain of extractable information for most applications, except maybe if you need 
to identify a significant zonation in a specific phase (e.g., Ca-Na in plagioclase). In this case, 
you should certainly first discuss with the lab manager... 
 
Use Figures A5.1 and A5.2 as a reference to define the minimum counting time per frame 
to reach the desired quality. 
 

 

 
Figure A5.1. Table of expected total number of counts received on each pixel of an element 
map as a function of the image size and counting time a minimum of 1000 counts per pixel is 

recommended. Average counts/px = SR * [Total time] / [Total number of pixel]. 

Left table: Time constant of 6 to 7 and a storage rate (SR) of ~85’000 cps. 
Right table: Time constant of 5 to 6 and a storage rate (SR) of ~50’000 cps. 
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A6) File handling in Pathfinder 
Below is a list of the important files created by Pathfinder during EDS analysis.  
 
A6.1) “Spectrum” mode 

• EMSA [text file] EDS data including energy vs counts data (at the end). 
 
A6.2) “Point ID” mode 

• PSMSA [text file] EDS data including energy vs counts data (at the end). 
• P_S [text file] Information on the point & area analysed.  
• PSREF [TIF file] (*) Raw BSE/SE image (without scale bar). 

 
A6.3) “Spectral Imaging” mode 

• PCM [TIF file] (*) Image of a principal component (filename “xxx CP1”, “xxx CP2”, …). 
• PCS [text file] EDS of a principal component (filename “xxx CP 1”, “xxx CP 2”, …). 
• SITIF [TIF file] (*) Base image (BSE or SE) at the resolution of the spectral image. 
• FZM [TIF file] (*) Image of a phase map (filename “xxx Phase1”, “xxx Phase2”…). 
• FZS [text file] EDS of a phase map (filename “xxx Phase 1”, “xxx Phase 2”…). 
• CSI [text file] Configuration file of the spectral image. 
• SI [binary file] Compressed binary data of the spectral image. 
• SIREF [TIF file] (*) Raw BSE or SE image at the full resolution (without scale bar). 

 
A6.4) Export files generated by Thermo 

• TIF [TIF file] Export of a BSE image (menu “File > Export Image as Full Res TIF”). 
• CSV [text file / XL] Export of quantitative analysis of selected EMSA file or Point ID. 
• PPTX [PowerPoint] Report export in the PowerPoint format. 
• DOCX [Word] Report export in the Word format. 
• RAW [binary file] (**) Export of SI binary file using Lispix format (required for iSpectra). 
• RPL [binary file] (**) Export of SI parameters using Lispix format (required for iSpectra). 
• BMP [BMP file] Export of a BSE image (from menu “File > Export as Bitmap”). 

 
A6.5) Various parameter file (required by Pathfinder) 

• AcqProps.tnp Setting for the acquisition properties. 
• NSSProject.xml Information about your Pathfinder Project. 

 
 
 
 
 
 
 
 
(*) These “hidden” TIF files can be opened with any imaging program (Paint, Photoshop, 
etc.). Just force opening the file with your favourite image editor. 
 
(**) Use the SIConvert.exe tool to convert SI file into RAW and RPL files (see iSpectra 
manual). You will need to copy the SIConvert.exe file along with all .CSI and .SI files from 
your map in a single folder. 
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A8) Troubleshooting for bad analysis & other known problems 
If all elements are analysed, your standard-based quantitative analysis should yield 
between 98 and 102%, with occasional outliers slightly outside these limits. There are 
multiple reasons for obtaining odd totals. Check first the following common issues. 
 
A8.1) SAMPLE related problem… 

• Are all elements analysed? Do your sample contain non-analysed element (e.g., 
H [H2O], C [CO2], B, N, Li, etc.)? Have you forgotten some important element(s)? 

• Is your sample well-polished? Are your analysis points correctly set on a flat area, 
not too close to a phase edge and not over a crack? 

• Is your sample mounted horizontally (i.e., not tilted inside its mount)? 
• Are you analysing homogeneous domain? If inhomogeneous (e.g., quenched glass 

with micro-crystals), you might “naturally” expect bad totals… 
• Problem of coating: Is your sample charging? If you observe flashes or strong 

image deformation in SE imaging mode, this is likely a problem of charging. The 
charging can be small and may NOT induce (too much) imaging aberration. 
Therefore, you should also check the Duane-Hunt limit: 

o Acquire a long spectrum (ideally over 120 seconds); 
o During the acquisition, zoom in around the energy range of the acceleration 

voltage you are using (usually 15 keV). All X-rays (= mostly bremsstrahlung) 
should end very near to the acceleration voltage you are using (e.g., 15 keV 
mark) with a few abnormal values beyond (= uncorrected sum peaks). 

o At the end of the acquisition, check if you have a significant (> 0.1-0.2 keV) 
deviation from the acceleration voltage used (e.g., 15 keV). If so, the 
difference from the acceleration voltage used equals the negative charge 
(potential) on your sample. If this happens, you must remove your sample, 
repolish it to remove the coating, and re-coat it with 20 nm carbon. Ask for 
assistance if necessary.  

• Are you analysing “beam sensitive” material (e.g., hydrated phase, Na- or K-rich 
phase, carbonate, phosphate, sulphate, etc.)? If so, it is possible you damaged the 
mineral during the analysis. In this case, do NOT use the “point” analysis, and 
rather draw a “rectangle” or a “circle” over a large area (several µm if possible). 

 
A8.2) HARDWARE problem… 

• Is the dead time (DT) between 20 and 30%? 
• Have you set the Time Constant to “Rate 2” in the EDS acquisition setup? 
• Is the Working Distance (WD) set at 10 mm on JEOL? If so, Pathfinder should 

indicate WD 9.7 mm in Pathfinder at 15 keV (or 9.8 mm at 20 keV and more). 
• Have you adjusted the Z-stage to the optimum focus point (sharpest image)? It 

should be between 10 and 11 mm for quantitative analysis. 
• Is the beam current stable and adequate (usually 2-3 nA)? Insert the PCD and 

check the ammeter for the actual value and its stability over the time of an analysis 
(usually 30 to 60s). 

• Are you correctly analysing at high magnification (≥ 500x)? Off-centred analyses 
points will yield lower totals as they are not anymore in focus with the EDS detector. 

• Check the alignment of beam aperture; if (strongly) misaligned it can partially 
block the electron beam and cause erroneous beam current reading. 
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If you are still getting trouble reaching good totals despite carefully checking all the above 
points, contact the lab manager or the assistant. An updated calibration might be required, 
or some other issue occurs. 
 
A8.3) Other common problem 

• If the ammeter is not responding, this is likely since someone turned it OFF… To 
reactivate it, start Pathfinder, and ask to run one random analysis. After a while, the 
ammeter should re-initialise itself. Try to get an analysis. It should now work… 

• In imaging mode (SE, BSE, CL), you might sometime see a shadow on one corner 
or on one edge of the image. This is most likely due to a very bad alignment of the 
beam aperture. To fix this problem: 

o Lower the magnification to the minimum (30-40x) 
o Set the image signal to SEI  
o Move sequentially the X and the Y axes of the beam aperture to minimize 

the shadow effect and get the highest signal intensity without any shadow on 
either side. 

o Perform then a fine tuning of the beam aperture at high magnification 
(>2000x) as described in the beam alignment procedure in Section F. 
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A8.4) Abnormal and known hardware-software bugs 
 

The following list abnormal behaviour that will hopefully be fixed one day… 
 
A8.4.1) Wrong EDS energy calibration 
Starting in April 2019, we have observed a few times a shift in the X-ray peak position. 
This is due to the EDS hardware losing its calibration. This is NOT visible on low X-ray 
energy lines (e.g., O Ka or Si Ka) and should be observable at higher energy (> 5 keV). 
Check the position of the Fe Ka X-ray line (or any other line > 5 keV) and ensure it 
matches the theoretical position (Fe Ka = 6.40 keV; Fe Kb = 7.06 keV). 
 
If you observe a significant shift in energy (> 0.1 keV, see Fig. A9.3.1), call for assistance, 
or perform the reset of the Pathfinder box as described below: 

1) Select the acquisition mode “Spectrum” in the left menu. 
2) Open the tab “Detector Status” on the bottom right panel. 
3) Click on “Advanced Status”. It launches the program “FrontEnd Status”. 
4) Close the software “Pathfinder”. 
5) Click on the button “Reboot” in “FrontEnd Status”. The connection light turns red 

(disconnected). Locate the white box behind the Thermo PC (behind the table); wait 
5-10 seconds until the indicator light on the top of this box turns green. 

6) In “FrontEnd Status” click on “Reconnect”. The connection light should turn green in 
the software. If not, you have clicked too early (the hardware was not fully 
restarted). Wait and try again. If you still cannot connect, ask for assistance. 

7) Restart the Pathfinder program. 
8) Re-run an analysis and check the sum. Ask for assistance if you still observe a shift 

in the energy of a high-energy X-ray line. 
 
A8.4.2) “Infinite” error message when closing Pathfinder 
There is a non-reproducible (apparently 
random?) error sometime occuring when 
exiting Pathfinder. First, don’t worry, all 
your data are safe! See screenshot aside. 
 
When this happens, use the keyboard 
connected physically to the left computer 
(usually above the left computer), and press 
CTRL + ALT + DEL. Open the Task Monitor 
and force closing the NSS / Pathfinder 
program running. This should automatically 
clear out all errors.  
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